


EPILEPSY WARNING

Some people are susceptible to epileptic seizures or loss of consciousness
when exposed to certain flashing lights or light patterns in everyday life.
Such persons could risk a seizure while watching televised images or playing
videogames. This can occur even if there have been no previous medical
problems or history of epilepsy. The following symptoms are characteristic of
epileptic seizures: blurred vision, eye or face twitches, trembling arms or legs,
disorientation, confusion or a temporary loss of bearings. During an epileptic
seizure, the loss of consciousness or convulsions can lead to serious accidents
in the case of a fall. Stop playing immediately if you recognise any of these
symptoms. We strongly recommend that parents watch over their children while
they are playing with a videogame, as children and adolescents tend to be
more prone to epileptic seizures than adults.
If these symptoms appear, STOP PLAYING IMMEDIATELY AND CONSULT YOUR
DOCTOR. Parents and tutors should keep an eye on the children and ask them
if they are experiencing some or all of the above mentioned symptoms. Children
and adolescents are more prone to experience these effects related to the use
of videogames than adults.
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CHAPTER 1: GETTING
STARTED

1.1 INSTALLATION 
Before you install Hotel Giant 2, please take a moment to review the Minimum and
Recommended System Requirements of the game. Your computer should meet all of
the Minimum Requirements so that Hotel Giant 2 may run. If it meets or exceeds the
Recommended Requirements, you will find game performance greatly improved.

Minimum System Requirements
Operating system Windows® 98, 2000, ME, XP or Vista (Windows® 95 and NT

not supported)
CPU type and speed 1.5 GHz Intel® Pentium® 4 or processor of the same grade
Memory 512MB RAM
Hard drive space 2 GB
Graphics card NVIDIA GeForce 5 series or above, ATI Radeon 9 series or

above, with 256MB video memory 
Other requirements DirectX® 9 compatible sound card; Keyboard; Mouse

Recommended System Requirements
Operating system Windows® 98, 2000, ME, XP or Vista (Windows® 95 and NT

not supported)
CPU type and speed 2.5 GHz Intel® Pentium® 4 or processor of the same grade
Memory 768MB RAM
Hard drive space 2 GB
Graphics card NVIDIA GeForce 5 series or above, ATI Radeon 9 series or

above, with 256MB video memory
Other requirements DirectX® 9 compatible sound card; Keyboard; Mouse

To install Hotel Giant 2 follow the procedures outlined below:
1) Start your computer and wait for Windows to finish loading.
2) Insert the Hotel Giant 2 disk into your computer disk drive. If you

have autorun enabled you will see the installation window appear
onscreen. Follow the onscreen instructions and install Hotel Giant 2
on your computer.

If the installation screen does not appear, it is likely that autorun
is disabled. Follow these procedures:
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1) Click START on the taskbar
2) Select SETTINGS, then CONTROL PANEL
3) Double click ADD/REMOVE PROGRAMS
4) Select INSTALL, NEXT and BROWSE
5) Locate the program called SETUP on the DVD-Rom and click OK
The installation screen should now appear. Follow the on-screen instructions and
Hotel Giant 2 will be installed on your computer.

1.2 CONFIGURING YOUR SETTINGS
After installation, you may want to configure your in-game settings such as the
graphics quality and the music volume before you start your game session. You
can do this by going to the Options Menu and changing the different settings found
under four different options categories: Video Settings , Audio Settings ,
Input and Interface Settings , and Default Wall/Floor/Ceiling Textures .
Play around with the different settings found under the graphics options to see
which settings are optimal for your computer. Just remember that the more
options you set to a high level, the better-looking the game will get but, adversely,
the greater the performance hit the game will incur. If you do not wish to fiddle
with the options, however, and would rather dive into the game at once, you can
simply set the Overall Graphics Quality to suit your needs.

Changing the Resolution
To change the game’s screen fidelity, simply choose your desired setting from the
Screen Resolution drop box. Note that screen resolution can only be changed
while you are in the main menu. You will not be able to change this setting during
a game session.

1.3 USING THE MOUSE
Hotel Giant 2 is controlled using a combination of keyboard and mouse controls.

The following table describes the mouse controls:
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Command or Phrase Means

Left click, Select Depress the left mouse button

Right click Depress the right mouse button

Double click Rapidly depress the left mouse button twice 

1.4 GAME MODES
Hotel Giant 2 has three game
modes to choose from –
Campaign, Random and Sandbox
Hotels. The Campaign Mode
comprises a series of scenarios
that requires you to advance
through them in a specific order.
Random Game allows you to play a
standalone game with attributes
and goals for your missions
predefined by you beforehand.

Sandbox Hotels are pre-built hotels that serve to showcase what a fully
developed hotel in Hotel Giant 2 looks like.

Campaign
There are three types of campaigns available in Hotel Giant 2.

The first, the Learning Campaign, combines tutorials and gaming scenarios to
teach you the basics of the game while challenging you with specific goals. If you
are new to the series and are playing it for the first time, it is highly recommended
that you start your game at the first tutorial scenario of the Learning Campaign.
You can do so by simply answering “Yes” once you are asked if it is your first time
playing the Hotel Giant series.
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CALLING ALL EXPERIENCED PLAYERS
For players that have already played the Hotel Giant series before, you may wish to
skip past the basic tutorials and dive directly into the new features of Hotel Giant 2.
To do so, simply answer “No” to the question “Is this your first time playing the Hotel
Giant series of game?” when you initiate the Learning Campaign. You will be
transported to the advanced tutorials that introduce the game’s new features.

If you feel that you need to brush up on your basics once more. Simply click on the
left arrow on the scenario introduction screens to move to the earlier tutorials.

The second, the Hotel Giant Campaign, is
designed for advanced players who have
finished the Learning Campaign and are looking
for a more superior challenge. There are 15
scenarios in this campaign with each
subsequent assignment ramping in difficulty.

The third, the Random Campaign, generates a
random series of scenarios for you to play
based on the difficulty level that you have chosen.

Random Game
A random game lets you play a standalone game based on the difficulty and
gameplay parameters that you have set. Below is a list of parameters that you
can set for your game:

1) Game difficulty – drag the slider left or right to decrease or increase difficulty
respectively. You can immediately see the effect of this change with the
dynamically changing goals.

2) Number of cities in play

3) Choice of cities to play

4) Time limit to reach your goals
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5) Beginning the game with a pre-built hotel – If you wish to start the game without
a pre-built hotel, simply clear the blue box to the right to clear the pre-built hotel
field to “None.” If you wish to start with a pre-built hotel, simply cycle among the
different hotel types by clicking the left or right arrows.

6) Randomize allows you to change all the parameters to a new random set.

New Random Game
Sandbox Hotels

The Sandbox Hotels mode allows you to choose
between three different types of fully-furnished
hotels to explore. These hotels have been pre-
designed to serve as a guide to what a complete
hotel looks like. In this mode you are only allowed
to view hotels. You will not be allowed to modify
the items nor the rooms of the hotels.

CHAPTER 2: BUILDING
YOUR HOTEL

If you have chosen to play a
random game with a pre-built
hotel, your initial view upon loading
the game will be that of your hotel’s
exterior in the city map. If you are
playing without a pre-built hotel,
however, you will be looking at an
empty piece of land.

9
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2.1 EXTERIOR VIEW
The exterior view shows your hotel’s exterior set against the backdrop of a local
city. Here, you may move the camera to explore the city by moving the mouse
cursor to the four sides of the screen or by clicking on an area on the mini-map
found on lower left hand corner of the screen. You can also rotate the camera by
moving the mouse while holding the right mouse button.

The city map is dotted with several pieces of land that are available for use. These
tracks of land are denoted as coloured squares on the mini-map. Green tracks
denote land that is available for purchase. Blue tracks are land that you currently
own. Red tracks are land that has a hotel built on top of them. And the yellow
track is land that is currently selected.

2.2 BUYING LAND
Assuming that a random game was started
without a pre-built hotel, you must first buy
land before you can start constructions.
There are two ways to do so.

The first option is to purchase land through
the Buy Land icon . Selecting this icon
will open a new panel showing a list of
properties that are up for sale.
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2.3 BUILDING A HOTEL
To build a hotel, click the Build
Menu icon from the Tool Wheel
and select Hotels from upper half
of the Build Menu.
Select from the available range of
hotels. These include Urban
Modern Hotels, Urban Classic
Hotels, Inns, Motels and Resort
Hotels which are represented by
icons found at the lower half of the
Build Menu. Pay attention to the

dimensions and number of floors given for each building – you may need to
purchase additional land adjacent to what you already own in order to
accommodate the building that you wish to construct. If you plan to add lots of
facilities inside your hotel (like a health club or an executive lounge) you will also
need plenty of floor space.

Once you have found the hotel you require, simply select the hotel from
the Build Menu and place it on your property.
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2.4 UPPER TOOLBAR
The upper toolbar, located at the top of the screen, contains time controls, access
to the game menu, hotel information and a financial readout.

1   2    3   4    5            6                  7                 8                   9           10

1. Floor Number – left click on the floor number to travel instantly to the floor that you
wish to go to.

2. Floor Up/Down – left click on the up or down arrows to travel up or down a floor
respectively. You can also right click on the up and down buttons to immediately get
to the ground floor and penthouse respectively.

3. Information Screen – access the Information Screen (shortcut key F1)

4. Switch Hotel – switch over to another hotel that you currently own.

5. View Toggle – toggle between interior (shortcut key F2) and exterior (shortcut key
F3) views. Note that the ‘toggle to exterior view’ icon is shown on the above toolbar.
When the hotel exterior is being viewed, the icon will change to the ‘toggle interior
view’ icon .

6. Cash and Profit Indicators – the left hand readout displays your company’s current
cash on hand. The right hand display shows your current profit rating. A green figure
indicates profit whilst a red figure represents a loss.

7. Game Speed - from left to right the four controls are: Pause (shortcut key 0), Normal
Speed (shortcut key 1), Higher Speed (shortcut key 2), Fast Forward (shortcut key 3)
and Advance Game Time by One Week (shortcut key 7).

8. Game Date & Time - displays the current game date and time.

9. Current Hotel - adisplays the name of the currently selected hotel. If you have more
than one hotel, arrows will appear on the sides to allow you to cycle through your hotels.

10. Game Menu - Opens the Game Menu where you can save and load your
current game, save and load your room layouts, access the options
menu and quit the game proper.
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CHAPTER 3: DESIGNING
YOUR HOTEL

3.1 INTERIOR VIEW
The interior view is accessed using the view toggle button on the upper toolbar. This
view is used for designing and displaying the interiors of your hotel.

The Three Viewpoints
Under the interior view, you are given
the choice of three viewing angles to
examine your hotel. To switch views,
simply select any of the three
buttons marked as Isometric
(shortcut key Q), Perspective
(shortcut key W) and Top (shortcut
key E) that are located just above the
wheel of the mini map.

When you first enter the interior, it
will be shown in Isometric View. This

view places the camera on a three quarter angle overlooking your hotel floor.

Perspective View places the viewpoint on the level of the hotel floor, essentially
allowing you to “walk around” and see how your hotel looks from the customer’s
point of view.

Top View presents an overhead viewpoint looking straight down the current floor.

Navigating with the Three Viewpoints
ISOMETRIC AND TOP VIEWS
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Mouse

• Move the mouse to the edge of the screen to scroll the view.

• Hold down the right mouse button and move the mouse up or down to zoom.

• Hold down the right mouse button and move the mouse left or right to rotate
the view.

• Hold down the Shift key and the right mouse button at the same time and move
the mouse up and down to change the vertical camera angle.

• Alternatively, if your mouse has a scroll wheel, you may use the wheel to zoom

Cursor keys

• Use the Up, Down, Left and Right keys to scroll the view.

• Use Shift+Up or Shift+Down to alter the vertical angle of the camera.

PERSPECTIVE VIEW

Mouse

• Move the mouse to the top and bottom edge of the screen to move forwards
and backwards.

• Move the mouse to the left and right edge of the screen to move left and right.

• Hold down the right mouse button and slide the mouse left or right to rotate 
the view.

• Hold down the right mouse button at the same time and move the mouse up
and down to change the vertical camera angle

Cursor keys

• Use the Up and Down keys to move forwards and backwards.

• Use Left and Right keys to rotate the view.

• Use Shift+Up or Shift+Down to alter the vertical angle of the camera.
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3.2 LAYOUTS & OBJECTS
You can define layouts or place objects whilst viewing the interior of your hotel.
Layouts represent the room’s shape and its contents. Objects are the items/content
that populate the layouts. You can save your most oft-used layouts to allow for quick
placement of ‘new’ rooms within your hotel. For example, you may have saved a
“Deluxe En Suite” room layout that comprises a bedroom with adjoining bathroom.
In it you have meticulously placed each object (canopy bed, luxury bath, big screen
TV, etc.). Filling a whole floor with this layout is easy – just load the layout and
“stamp” each room on the desired position.

3.3 TOOL WHEEL
The buttons associated with layouts and objects are located on the tool wheel at
the bottom left corner of the screen. The following guides explain each set of icons.
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1. Viewing Angles - the three buttons are used to alter the viewing camera (see
Chapter 3 – The Three Viewpoints ).

2. Customer List - access information related to your customers (shortcut key
F6)

3. Staff List - access information related to your staff (shortcut key F7)

4. Rooms and Facilities List - access information related to your rooms
(shortcut key F8)

5. Open/Close Toolbar - toggle to open or close the Tool Wheel

6. Message Log - displays a list of on-screen messages relating to the operation
of your hotel.

7. Mini Map - is a top down representation of the current hotel floor plan. You can
left click on any part of the mini map to immediately move your view to the
selected location.

8. Open/Close Hotel - use the “Open Hotel” button to open your hotel to the
public. Once your hotel has been opened the button will be replaced with the
“Close for Renovation” button . Use this button to temporarily close your
hotel if it requires major layout changes.

9. Video Recorder - captures video from your current viewpoint (see Chapter 3 -
Capturing and Viewing Photos and Videos.)

10. Photo Camera - takes a photograph of the current scene in your hotel and
stores the image in the Photo Album (shortcut key P).

11. Photo Album - repository for all captured images and video for your game (see
Chapter 3 - Capturing and Viewing Photos and Videos.)

12. Object, Texture and Room Menu - open the Lower Toolbar that allows for
the selection and modification of objects, textures and rooms for placement
in the hotel (see Chapter 3 – Defining a Layout.)
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13. Show Hide Walls - the three buttons are used to hide walls (shortcut key
R), show back wall only (shortcut key T) and show walls (shortcut key
Y). Experiment with each alternative to make placing objects easier.

3.4 LOWER TOOLBAR
The Lower Toolbar that sits beside the Tool Wheel houses the tools for modifying
the interiors of your hotel. Here, you are given the option of adding rooms to your
hotel, place objects in rooms and change the textures of your walls among its
many functionalities. To open the Lower Toolbar, simply select the floor of your
hotel, and then press the Object, Texture and Room Menu button .

3.5 DEFINING A LAYOUT
Adding Rooms and Layouts

To define a layout (or room), first
change to interior view and
select the floor on which you
wish to create the layout. Select
“Room” from the Lower Toolbar
to open the Layout Menu.

The buttons on the left-side
window represent the different
layout classes. From top to
bottom they are Guest Room,
Restaurant, Coffee Shop, Bar,
Health Club, Business Center,
Game Room, Billiard Room,

Swimming Pool, Library, Cake Shop, Jewelry Shop, Arts and Crafts Shop and
Electronic Shop.

Select the layout class you are interested in by clicking its button. A
new window will open immediately beside the Layout Menu. If there
aren’t any currently defined layouts for the class, only the New
Room button will be displayed [except in some scenarios]. If you
have defined other layouts their names will be shown.

17
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Select New Room button and hold down the left mouse button on the hotel floor.
Drag to the desired size of the room you wish to create. Watch the rectangle that
is created as you drag your mouse. If it is red, the room cannot be created – either
the layout is too small or it overlaps an existing layout, wall or object. Always pay
attention to the message at the top of the screen as it tells you explicitly why the
new room cannot be created. If the color changes to blue, you may release the
mouse button and your room will be created. A new button with the default name
of the layout class (“Guest Room 1”, for example) will then be added to the
window beside the Layout Menu. This is your Layout Stamp for that room. It can
be renamed by selecting the Rename button . You may select your new Layout
Stamp and place copies of the created room to quickly fill an entire floor with
guest rooms, for example. Any modification you make to one example of the
room, such as adjusting its size or the objects within it, will be mirrored in all
rooms of that type. So adding a new furniture item to a guest room means you
only have to do it once and not in every individual room of that same layout.

Resizing, Moving & Deleting Rooms
To resize rooms that have already been built, select the Adjust Room Size/Move
Room button and then select the room in the main view that you wish to adjust.
Drag any of the green squares that appear at the corners of the room. Remember
that you are not just adjusting this individual room but ALL of the rooms that share
the same layout name (e.g. Guest Room 1). Consequently the rectangle may remain
red even if the current modification appears to be valid. This implies that other
rooms using the same layout cannot be changed to the new size due to space
restrictions.

To move a room, select the Adjust Room Size/Move Room button and then
select the room. Left click the room and move the cursor to the new location. The
layout will follow your cursor. When you are happy with the new location, left click
to place the room.

To delete a room, select the Delete Rooms button and then double
click the room you wish to delete. Please note that this will delete
individual rooms. If you wish to remove a layout and all rooms using the
layout altogether, you can select the button representing the layout and
then left click Delete button. A pop up box will ask you to confirm the
action.
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Adding Sub-Rooms
Some layout types allow for another layout to be created within the first. An
example of this can be found with the Guest Room layout – a bathroom layout
can be defined within the guest room. When you see the Room button placed
alongside the Object and Texture menu, you may then build a sub room related
to that layout type.

TROUBLESHOOTING: 
I CAN’T ADD A NEW LAYOUT 

If you’re having problems placing a layout, the following might be the cause:

• There is not enough room size.

• The proposed location of the new Layout blocks access to an existing layout,
wall or other object.

• You do not have enough cash.

Customizing Layouts
Double clicking on a layout opens a details menu from which you may alter
parameters rele¬vant to the room (such as admission fees, the number of staff,
or the quality of toothpaste). By doing this you can fine-tune the layout to
maximize its productivity and attractiveness to custo¬mers. See Accessing
Details of Rooms and Facilities section for more information.

You can also review the complaints and needs of customers, or view the room’s
financial statement (see Chapter 5 – Understanding Customer Satisfaction.)
Some objects, TV’s for example, can also be customized (see Chapter 3 – Object
Customisation)
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3.6 PLACING OBJECTS
Adding Objects
Once you have placed a layout you’ll want to add objects such as chairs and beds
and perhaps change the wallpaper for your walls as well. To do so, first select the
layout that you wish to work on by left clicking on its floor. Then select the Object,
Texture and Room Menu button from the Tool Wheel to open the Lower
Toolbar. Under this toolbar, select the Object button to open the Object Menu.

The Object Menu provides a list of all objects relevant to that parti¬cular
room/layout from which you may select and place. The Texture Menu allows you
to set the look of the floor, walls, and ceiling in the room. To place an object, select
it from the Object Menu and move the cursor to the desired position. Hold the left
mouse button down and slide the mouse either up, down, left or right to change
the orientation of the object.

If the rectangle underneath the object is blue, you may left click to place the item
there. If it is red, it means that the item cannot be placed there. Always pay
attention to the message at the top of the screen as it tells you explicitly why the
object cannot be place at its current location. If you decide not to place the
currently selected object, a right click will remove it from your cursor.

Some objects require operation by a hotel staff member. Such objects will be
placed with the accompanying staff member when your hotel is open for
business. For example, placing a reception desk will automatically add a
Reception Clerk. You therefore are not required to hire staff and assign them to
each relevant object.

Also note that the styles of furniture available to you are different depending on
the type of hotel you have. As an example, an Urban Classic Hotel will not have
the same furnishings as those of an Urban Modern Hotel; classic hotels will only
have traditional furniture available while modern hotels are bent towards
contemporary designs.
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One way to place objects quickly in your hotel is by cloning an already placed
object. Hold down Alt and left click the placed object that you wish to copy. A clone
is immediately attached to your cursor. Place it as you would any other object.

When you select an object from the Object Menu (and it is attached to your
cursor) you can cycle through all other available types by pressing the [ and ]
keys.

TROUBLESHOOTING: 
I CAN’T ADD NEW OBJECTS

If you’re having problems placing an object, try checking for the following:

• Smaller objects such as telephones and small vases must be placed on top of
other objects such as tables as they would be in real life.

• The orientation may not be correct. Some objects, such as bathroom sinks for
example, must have their backs against the wall. Windows must be placed against
external walls.

• There is not enough space.

• The object’s interactive locations are blocked. These locations are shown in green
and represent the places staff and guests will stand when they interact with the
object.

• You do not have enough cash.
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Moving and Deleting Objects
To move existing objects to a different location, select the Reposition Objects
button and then select the object that you wish to move. Drag the object to
the desired location and orientation.

To delete an existing object, select the Delete Objects button and then double
click the object that you wish to remove.

3.7 OBJECT CUSTOMIZATION
As with layouts, adjusting parameters can refine the use of some objects. If you
have placed a TV for example, you can double click the TV to display its Item
Detail Menu on which you may decide what level of service the TV will offer
(cable TV, Video Games, Etc.). Adding high quality services to objects within a
room will increase the attractiveness of the room to potential users.
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The following table lists all of the objects that may be customized.
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What object? Found where? Choices 

Televisions Guest Room 
Cable TV, Satellite TV, Movie on Demand, and Video Game on

Demand may all be chosen to provide a range of in-room
entertainment.

Computers 
Computer Room
within Business

Center 

Internet Connection speed can be set via the Computer Room
Detail Menu to one of the following: None, Low speed, Medium

speed, High speed, or Ultra High speed.

Lights Any room 
The Brightness and Radius of any lamp type can be modified

via the Light Item Detail Menu by double clicking a placed light.

Reception Desks 
(for Business Center)

Business Center 

Select as many of the following services as you wish to
increase the attractiveness of your business center: Postal and
Parcel Mailing, Courier Service, Interpretation and Translation

Service, and Secretarial Services.

Front Desks Lobby 
Set the number of front desk clerks and the function 

of the front desk, which can be either Reception,
Cashier, Information or Concierge.

Lobby Doors Lobby entrance Change the appearance of the doors to suit your hotel.

Paintings and Wall
Photographs

Most rooms 
Adjust the vertical placement and 

the picture representation of the painting.

Fitness Equipment Health Club 
Change the color of a select number of fitness equipment to

match your needs.

Bathroom Utilities Bathroom
Change the color of the toilet bowls 
to suit the look of your bathrooms.



Adding Some Kick to Your Hotel
One of the more exciting object types that you can place
in your hotel is the Performance Stage. A Performance
Stage gives you the ability to hire live performers to
entertain your guests. These objects can only be added
to certain places in your hotel; namely the Lobby,
Restaurant, Coffee Shop and the Bar. There are several
types of performance stages and not all of them are
available to choose from in the beginning. Some of them
will even need to be unlocked from the Unlock Item
Interface (see Chapter 4 – 100% Customer Satisfaction
and Unlock Items)

The following types of performances are available in the
game: Piano, Violin Cello, Saxophone, Jazz Band, Rock
Band and Country Music. (Note: Jazz and Rock bands
require special performance stages which need to be

unlocked.) To hire a live performer, double click on a Performance Stage to open
its detail panel and select the Change Performance button.

A new window will open showing you a selection of performers that you can hire
that includes their corresponding performance quality and cost by the hour. And
once you have selected your performer, you can then fine-tune the performer’s
schedule in the Performance Stage’s detail panel such as the start time of the
performance as well as its duration.
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3.8 CHANGING TEXTURES
You can alter the look of a room by modifying the floor,
wall, and ceiling textures. Doing so is akin to laying a
new carpet, hanging new wallpaper or painting the
ceiling. To apply a texture change, first select the layout
that you wish to work on by left clicking on its floor. Then
select the Object, Texture and Room Menu button 
from the Tool Wheel to open the Lower Toolbar. Under
this toolbar, select the Texture button to open the Texture
Menu 

Textures Menu
Select the texture area you want (such as Floor) and the available texture types
are displayed. Left click to select the type you want. The texture is applied to the
room. If you select Texture Sets you are presented with texture sets that have
been predefined to match with each other.

You may also cycle through available textures when you are viewing the hotel
interior. To do so, use the following keys:

D & F change the Texture Sets of the selected layout or lobby

Z & X change the Wall Texture of the selected layout or lobby 

C & V change the Floor Texture of the selected layout or lobby 

B & N change the Ceiling Texture of the selected layout or lobby 
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Changing the Default Textures
When a new room layout is created, a default texture is used to paint the layout.
You can define these default textures for the walls, ceiling and floor through the
Options Menu opened from the Options Menu button on the Upper Toolbar. To
modify your game’s default textures, simply select the room type that you wish to
set default textures for and then choose the specific texture that you want for
ceiling, floor and walls of that room type. Alternatively, you can also select a room
that you’ve created and press the “U” key – the game will automatically use the
textures of that room as the defaults for that room type.

3.9 SAVING & LOADING LAYOUTS
Once you have defined and placed your layout(s) you may save your designs for
use in other hotels. Press the F11 key to access the Save Layout Menu. There
you can decide, by using the drop down menu, whether to save all layouts (from
the current hotel) or just a specific layout.

Press F12 to access the Load Saved Layout Menu. Use the drop down menu to see
all of the saved layouts or select specific saved layout types. Once loaded, the name
of the layout will be added to the layout stamp window for you to select and use.
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3.10 ACCESSING DETAILS OF ROOMS AND
FACILITIES
When you have built a room or a facility, you can double
click on its floor to call up its detail menu.

The two images on either side represent the
Information and Needs sections of the room/facility
detail menu.

The row of four buttons represents, from left to right,
the General Information , Finance , Complaints

, and Needs tabs of the detail menu. Looking at
the image of the Information Tab for a Guest Room
(left) you can see that you can alter the room rate and
view the satisfaction rating for that room. Use the
left/right scroll arrows to cycle through different guest
room types (if you have defined more than one) and
each individual room of the selected type. The drop
down menu at the top of the window, on the other
hand, can be used to access different layout classes that have been placed in
your hotel. The detail menus are generally similar for all classes with the
exception of some class-specific options (e.g. adjusting staff numbers in your
restaurant, admission price of your health club.)

Note: If you alter the room rate, the new room rate will only affect new room
reservations. Customers who have made reservations prior to the rate change
will pay the original price. This explains why you may not see an immediate
change to your income after a room rate adjustment.

Your customers’ comments are recorded in two areas: the Needs tab and the
Complaints tab. The amount of complaints or needs of your guests is indicated by
the amount of color that has filled up the tab’s icon. Red represents complaints
while yellow makes up your guests’ needs. The more color the tab icons are filled
with, the more complaints or needs you will likely have to deal with.
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You may also left click on the Rooms & Facilities List
button (shortcut key F8) on the Tool Wheel to access
a list of all available rooms and facilities with displays of
their profits and satisfaction ratings. From the list, you
can select a room to display its detail menu.

3.11 FACILITY TYPES
Some facilities require additional rooms or objects to be defined within the main
layout in order for the facility to function correctly. Below is a list of every available
room and facility with details of optional or necessary sub rooms and objects.

Lobby
The Lobby is the one area of a hotel that you do not need to define in terms of
layout. But in order for your hotel to run effectively it is essential that you place
certain objects.

Your Lobby must have a reception desk and a cashier desk. Both are ‘Front
Desk’ object types. When you place you first front desk object it is automatically
assigned as a reception desk. Similarly, on placing a second reception desk, it
defaults to cashier. Please note that you can alter the function of the front desk –
just double click the object and choose from the list of reception, cashier,

information, and concierge.

28



Note that because the reception desk is the
one place where customers can check in or
reserve rooms, your hotel will not have
any customers if you do not place a
reception desk in your hotel. The cashier
desk is required so that your customers can
settle their bills at the end of their stay.
Without it your customers would leave
without paying! The remai¬ning two desk
types, information and concierge, are

optional and each provides a specific function to enhance the service your hotel.

Guest Room
Guest rooms are obviously required so that your customers have a room in which
to stay. A bedroom and a bathroom are optional.

Double click the bathroom to access the amenities list. Use the list to define the
level of service provided by adjusting the quality and availability of the provided
soap, shampoo, conditioner, bath lotion, body lotion, toothpaste and toothbrush,
and hair dryer.

Restaurant
Having a restaurant is optional but not only does it provide a convenient place for
your custo¬mers to dine, it may also attract customers who are not staying at
your hotel. A restaurant must have a kitchen. Male & female restrooms, however,
are optional (see Chapter 5 – Setting up a Successful Restaurant)

Double click the restaurant to access its detail menu. Use the menu to alter the
number of captains and servers to cope with demand. You can also adjust the
quality of the ingredients and the price on a scale of 1 (lowest) to 10 (highest.)

Coffee Shop
A coffee shop allows your guests to enjoy a cup of coffee under a warm and
relaxing atmosphere. Male and female restrooms are optional.

Double click the coffee shop to access its detail menu. Use the menu
to alter the number of servers to cope with demand. You may also
adjust the quality of the drinks and the price on a scale of 1 (lowest)
to 10 (highest).
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Bar
A bar will attract a similar clientele to that of
the restaurant. Male and female restrooms
are optional.

Double click the bar to access its detail
menu. Use the menu to alter the number of
servers to cope with demand. You may also
adjust the quality of the drinks and the price
on a scale of 1 (lowest) to 10 (highest).

Health Club
A health club offers customers and non-staying customers the chance to exercise
or indulge in beauty treatments. The club must have male and female changing
rooms and at least one of the following:

- Beauty Parlor – where customers receive facials and beauty treatments

- Massage Room – where customers receive relaxing therapeutic massages

- Exercising Room – offers a range of fitness equipment for physical workouts

- Sauna Room – a temperature-adjusted room used for body cleansing and
purification

- Spa Room – offers invigorating waters to relax weary visitors

- Swiss Shower Room – provides a special shower that shoots hot and cold jets
of water to cleanse the pores

- Sunbed Room – provides UV-emitting sunbeds for customer tanning services

- Sound-wave Therapy Room – offers low-frequency sound therapy services to
provide customers with body tension
relief.

With the exception of the changing rooms
and restrooms, all of the above

charge an admis¬sion fee or
an hourly fee, which may be
adjusted via the Room Detail
Menu (accessed by double-
clicking the room floor).
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Swimming Pool
An indoor swimming pool provides a place for
your customers to relax by the poolside or take
a dip in the water. It must have male and
female changing rooms and restrooms.

Double click the pool layout to access its
detail menu and adjust the admission price
charged.

Business Center
A business center helps attract corporate customers to your hotel. The center must
have at least one of the following sub-rooms in order to function: a meeting room,
a computer room or an executive club lounge.

The meeting room and the executive club lounge charge an admission fee from
guests while the computer room charges an hourly fee. Double click a room’s layout
to access its detail menu for adjusting the fees.

For both the meeting room and the executive club lounge, you may specify from
the detail menu whether the rooms allow for wireless broadband Internet access.
You may also determine the Internet connection speed available in the computer
room ranging from None, Low Speed, Medium Speed, High Speed, and Ultra-High
Speed. Note that the total operating costs of the rooms are affected by the Internet
connection services chosen.

Double-click on a Business Centre Reception desk to set the following additional
services:

• Postal and Parcel Mailing 
• Courier Service 
• Interpretation and Translation Service 
• Secretarial Services 

The more services you select the more attractive your business center will be to
potential customers at the cost of a higher operating expense.
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Game Room
The game room provides customers with alternative entertainment with offerings of
darts, video games, and pinball machines for use. This facility does not require any
special sub rooms.

Double click the room to access the detail menu to adjust the room’s admission fee.

Billiard Room
The billiard room serves as another outlet
for your guests looking for an alternative
form of entertainment. You can place pool
tables and snooker tables in this room for
your customers to play with.

Double click the room to access the detail
menu to adjust the room’s admission fee.

Library
Provides a quiet place for contemplation and reading.This facility does not require any
special sub rooms.

Double click the room to access the detail menu for adjusting the admission fee.

Cake Shop
The cake shop allows guests to buy an assortment of breads, cakes and other
delicious pastries. This facility does not require any special sub rooms.

Double click the room to access the detail menu to adjust the store’s sales
discount percentage.
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Jewelry Shop
A high-return shop that gives guests a nearby outlet to buy jewelry. This facility
does not require any special sub rooms.

Double click the room to access the detail menu to adjust the store’s sales
discount percentage.

Arts and Crafts Shop
Gives guests a chance to buy souvenirs,
trinkets and mementos of their stay in the
hotel. This facility does not require any
special sub rooms.

Double click the room to access the detail
menu to adjust the store’s sales discount
percentage.

Electronics Shop
A store that carries a variety of electronics and computers for sale. This facility does
not require any special sub rooms.

Double click the room to access the detail menu to adjust the store’s sales discount
percentage.
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3.12 EXTERIOR FACILITIES
The concept of facilities has also been expanded to include facilities that you can
use to extend your hotel’s outside grounds. These facilities can all be accessed
from the Build Menu button on the Tool Wheel while in exterior view.

Selecting the button will call up the Build Menu. Here you will be given the choice
of what facility to add to your hotel’s property; namely a Recreational Park , an
Outdoor Swimming Pool and an Outdoor Rock-climbing facility . Beneath the
facility buttons are two other “modification” buttons that allows you to
move/rotate or outright delete the said facility.

Note: You should keep in mind that, just like building a hotel, you can only add
exterior facilities to land that you already own.

Recreational Parks
Parks allow your guests to roam outdoors and enjoy a relaxing stroll along
manicured greens. To ensure that your park work’s well, you should always be
mindful of where you place your Park Paths. People will move through your park

only in places where there is a path. A well
planned path network ensures that your
guests will be able to freely move through
the area and enjoy the park fully.

There are also a variety of plants, sculptures
and miscellaneous park objects for you to
choose and adorn your park. Take the time to
browse through the library of objects and
use your creativity to design your ideal park.
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Outdoor Rock-climbing
You may add some excitement to your hotel grounds by offering rock-climbing
facilities to your visitors.

Like any other facility or service in your hotel, customers must pay a price to use
the rock climbing facility (unless you’re really generous.)  To adjust the pricing,
double-click on the facility to open the facility detail panel.

Outdoor Swimming Pool
Swimming pools are a staple hotel facility that guests use to relax and have fun
in cool soothing waters. In Hotel Giant 2, you are given the ability to customize the
construction of swimming pools according to your desired size, shape and style.

To build your swimming pool, simply select your choice of Type, Shape and Style
of swimming pool tiles from the swimming pool menu (found under the Build
Menu) and lay the tiles down on an empty location on your hotel’s property. If in
the event, you’ve made a mistake and wish to change the layout of your pool,
simply remove the existing tiles by selecting the Delete icon to switch to the
Delete action mode and select the tiles that you want to remove.

Just like the Recreational Park, the Outdoor Swimming Pool includes a host of
objects and sub-facilities for you to add. These include safety objects such as
ladders, slides, pool lights, wave machines, dive boards and lifeguard chairs as
well as recreational objects such as sun loungers and pool spas.

Note: Guests will not use the swimming pool unless changing rooms have been
provided in the pool area.
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3.13 OPENING AND CLOSING YOUR HOTEL
Once you have defined all of your rooms and placed all the objects that you want,
you should open your hotel to general public. To do so, simply press the Open
Hotel button found at the bottom right of the Tool Wheel and the hotel will
automatically be opened for business. If you wish to make major modifications to
your rooms and facilities, left click on the Close for Renovations button (which
replaces the Open Hotel button when the hotel is already open for business) at
the bottom right of the Tool Wheel.

3.14 CAPTURING AND VIEWING
PHOTOS AND VIDEOS
You can use the Photo Camera (shortcut key P) and the Video Recorder 
found in the Tool Wheel to capture still images and videos respectively of the
current scene of your hotel. The images and videos are stored inside the Photo
Album that is also found on the Tool Wheel.

Selecting the video camera tool will open a small recording control window with
three buttons: Record , Stop and a toggle to turn off or turn on the user
interface during video recording. Your video will automatically be saved to the
Photo Album once you press the Stop button during recording.

Under the Photo Album, you may use the buttons found along the bottom of the
album to view all your available photos, watch your recorded videos , delete
media or copy images from your photo album to your photo collection
folder .
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CHAPTER 4: 
RUNNING YOUR HOTEL

You can access various types of information about your hotel
and your corporation through the Information Screen button

on the upper toolbar.

Doing so will call up a Side Toolbar that contains detailed
info of various aspects of your company. Below are the
descriptions of the categories found on the Side Toolbar.

Hotel Details – select to take detailed look at various aspects
of a particular hotel 

Company Information – select to view company information
in more detail 

Score & Goal Information – select to view score and goal
information 

Market Research – discover how customers decide which
hotel to stay in.

100% customer satisfaction and unlock items – unlock
special reward items from your fully satisfied customers

4.01 HOTEL DETAILS 

This screen displays comprehensive information regarding the
currently selected hotel. It is sub-divided into 7 parts (each
represented by a tab at the top of the window): Room Status,
Customer Satisfaction, Rooms and Facilities, Financial Reports,
Employment Policies, Advertising and Hotel Packages.
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Room Status
The Room Status screen allows you to alter the price of rooms using +- spinners.
The two graphs below the room list show the occupancy rates, both future and
past, of all rooms. Use the drop down filters to adjust the time period of the
graphs and to select the type of guest room to be displayed.

Customer Satisfaction
The Customer Satisfaction screen is spilt into two sections. The first section
displays the satisfaction ratings and numbers of needs and complaints for all
guest rooms. The second section displays satisfaction ratings for the rest of the
hotel. Use the information here to target areas deemed by your customers to be
substandard.

Rooms & Facilities
The Rooms & Facilities displays a list of layouts by type and offers a

financial breakdown by current month or last month (left click the
This Month button to toggle between the two periods).
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Financial Reports
The Financial Reports screen gives you access to a more detailed financial breakdown
of your hotel’s performance categorized by your last and current month’s performance
as well as your overall performance for the current fiscal year.

Employment Policies
The Employment Policies screen provides an overview of average salary,
service quality, and the number of employees working in your hotel. Salaries
offered to potential employees and training costs can be adjusted by using the
relevant +- spinners.

Higher salaries will attract new staffs that possess higher service abilities.
Setting a higher budget for employee training, on the other hand, will boost the
service abilities of existing staff faster.

If you wish to fire an individual employee, you must access the employee’s
detail menu (called up by double clicking on the employee) and doing so there.
When the employee is fired, the game will automatically hire a new employee
as replacement. If, however, you fire a Captain or Server in a bar or restaurant,
or a Front Office Clerk manning a desk that has more than two staff, you will
have to hire the replacement by yourself. The service quality of the new
employee will be related to the level of salary that you offer.

Your employees’ uniforms can
also be chosen and customized
through this screen. To do so,
simply change the appropriate
spinners for uniform set and
uniform colors at the bottom of
the Employment Policies
Window.
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Advertising
The Advertising screen allows you to attract new customers, by commissioning
advertising campaigns. The campaign is targeted at increasing awareness in the
public of a specific part of your hotel by using a particular segment of the media.

To create an ad campaign, simply click the Add an Advertising Campaign
button and select the medium that will carry the campaign. The choices available
are TV, Radio, Newspaper, Magazine, Web and Directmail. Then choose the actual
focus of the campaign from the twelve choices available: Hotel Image, Hotel
Room, a Facility (nine to choose from) or a Package. The first will attempt to
improve the overall perceived image of your hotel to make it more attractive to
potential customers. (Note: The perception of your hotel contributes to your hotel’s
overall customer satisfaction and can be seen on the Customer Satisfaction
Screen under the Infor¬mation Screen) The remaining options are focused on
attracting greater use from potential customers of the particular subject at hand
(you may, for example, promote your hotel’s restaurant to attract more diners, or
offer a money saving Package (discussed below) to increase the number of
customers at the hotel.

Once you have decided on the focus, you must decide the duration and the
budget to be spent for the campaign.
Remember that the budget is spread across
the length of the duration, so make sure that
long campaigns have adequate funding.

Once you have made your decision just left
click the Add button and the new campaign
will be added to the list of current campaigns.
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The screen shot above shows several campaigns across different advertising
mediums. The campaign timescale is given in the ‘Duration’ column. The length
of the green bar shows the actual progress of the campaign.

Hotel Packages
The Hotel Packa¬ges screen allows you to define a combination of deals
designed to attract new custo¬mers to your hotel. For example you may decide
to offer a price reduction on a three nights stay in a guest room, with breakfast
and free access to the health club included in a packaged price.

To define a package, choose the New Package button and then enter a new
name for the package. Left click on each of the package areas (Accommodation,
Restaurant, etc.) and check any details that you wish to include in your package.
Adjust prices, number of nights and so on until you are happy with the details.
Please note that if any elements are shown in red, it means that they are invalid
(the reason will be given at the lower left of the screen).

Pay careful attention to the Price and Estimated Cost figures at the bottom of
the screen. The Price element, the first figure, is the money a customer pays for
the package. The Estimated Cost, on the other hand, is the actual cost the hotel
incurs to provide the package per customer.
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4.2 COMPANY INFORMATION
Selecting the Company Information button allows you to browse through a set
of information screens concerning your overall corporation. You may choose to
look from any of the five information windows provided.

Corporate Profile – displays statistics regarding all your hotels, such as the total
number of rooms, the average occupancy, etc.

Financial Statements – displays your corporation’s financial statements over
three periods: Current Month, Last Month, and Year.

Financial Graphs – displays graphs of your company’s Revenue, Profits, Cash,
and Assets over a 12-month period.

Bank Loans – borrow or repay bank loans. Use the +- spinners to adjust the
amount.

Awards – display awards that your hotels have won.

4.3 SCORE & GOAL INFORMATION
This section provides score and goal information and is divided in three parts.

Game Score
The Game Score screen displays your current score as broken down by 6 factors:

average customer satisfaction, average hotel class, monthly revenue,
monthly profit, goal achievement bonus, and time penalty. With the
exception of goal achievement bonus, each factor’s percentage
contribution to the overall game score is derived by an internal formula.
The sum of these percentages determines your final score in the game.
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Goals
The Goals section (shortcut key F4), displays your achievements against the
predeter¬mined goals for the Campaign or Random game in play. There are two
types of goals: main goals and side goals. To win a game, you must achieve all
the main goals. Achieving side goals is not a requirement in winning the game but
it will reward you with score bonuses. The main goals must be achieved within a
given time limit. You can see the time limit and the amount of time used on the
Goals screen as well.

Scenario Description
The Scenario Description screen details a short overview of the scenario and
gives you a bit of background surrounding the larger picture of your assignment.
This tab is only available in the Learning and Hotel Giant Campaigns.

4.4 MARKET RESEARCH
The Market Research (shortcut key F10) screen enables you to ask hotel
customers for their opini¬ons and comments. You may choose any currently
available city and all the current hotel customers in the city will be shown.

Customers colored green are presently staying in your hotel. Select one and you
will see their preferred room requirements, period of stay, trip purpose, and
favorite activities. Use this information to gauge what needs of your customers
the hotel is currently fulfilling.

It is just as important to view the comments of customers who have chosen to
stay in other competing hotels. These are marked in red. Their comments can
often be quite telling of your hotel’s weaknesses. Their reasons can be as simple
as a lack of preferred room type or facility. You would do best to listen and
address their complaints in order to court them back to your hotel.
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In the example shown above the
highlighted customer has chosen to stay
at a competitor’s hotel. Notice that the
decision was based on the hotel not
having her preferred room type.

The two percentage figures located at the
top of the screen represent the

percentage of custo¬mers in the selected city staying in hotels. The green figure
represents customers who decided to stay in hotels that you own and the red
figure represents customers who decided to stay in competitors’ hotels.

Use the Single, Double or Group buttons to select customers based on those
rooms.

4.5 100% CUSTOMER SATISFACTION AND
UNLOCK ITEMS
This screen allows you to unlock special reward items for use in your hotel. With
each customer that you have fully serviced to 100% satisfaction, you earn 1
Reputation Point to unlock items in this screen. Each locked item requires 1
Reputation Point to unlock.

There are two types of items to unlock. The first type of unlockable items is
objects that you previously could not access before but can access now, such as
a new type of bed or a new chair. Simply use the “Unlock Items” button to unlock
items of this type.
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The second type of unlockable items is objects that you already have access to
but presently cannot be added to your guest rooms. For example, exercise
equipments that are normally found in a health club cannot be placed in guest
rooms. By unlocking them for the guest rooms using this interface, you will be
able to offer your guests with in-room exercise equipment and thus increase your
guests’ enjoyment in their stay.

To achieve 100% customer satisfaction, you will need to provide the best service
to your guests. Granted this is not easy to achieve, but it is possible if you have
paid great attention to every detail of your hotel’s service process.

CHAPTER 5: 
SUCCESS WITH 
YOUR HOTEL

5.1 UNDERSTANDING CUSTOMER SATISFACTION
Simply creating a new layout/room and populating it with objects may not be enough
to satisfy your customers. They will always want more for their money. As discussed
previously, you can modify the services provided by a layout or object. But you do not
need to always second guess your customers’ needs because they won’t be shy
about telling you.
When you double click an active layout, a Room Detail Menu will be displayed
allowing you to view the room’s general information, financial standing, and customer
complaints and needs. The last two are very important. Studying them allows for a
greater understanding of how satisfied your customers are with specific facilities. It is
important to review such comments and needs regularly so that you may address any
shortcomings in your hotel. Low satisfaction rates will affect the image of your hotel
and that in turn will affect the number of customers willing to visit.
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In addition to complaints and needs, the following rules below apply to customer
satisfaction in general:

• Customers prefer larger guest rooms or facility rooms.

• Customers are happier with furniture and facility objects of
higher quality.

• The wider the range of furniture and facilities offered in a
guest room or a facility room, the happier the customers are.

• When a customer pays a high room rate or a high admission
fee to a facility, the customer’s expectation will be higher.

Visually customers may provide a clue as to their current
satisfaction. For example, if customers are left waiting too
long before being served in a bar or restaurant they will keep

looking at their watch. They may even display a question mark above their heads.
Their actions should prompt you to increase the level of service by employing a
greater number of servers. To find out exactly what the customers think about the
facilities in your hotel, double click an active layout to display the Room Detail
Menu.

Individual Comments by Customers
In addition to the general comments provided by customers, each customer can
be canvassed to ascertain specific needs and complaints. Furthermore, the
customer’s activity log will provide a snapshot of the movements of the customer
and help you decide which facilities you should promote. This information is
shown in the Customer Detail Menu. You can open the menu to access a list of
your hotel’s current customers by selecting the Customers List button from
the Tool Wheel. From the list that appears, select a customer to study.
Alternatively, you can also double click on any customer currently on screen to
open the Customer Detail Menu.

46



The Customer Detail Menu that appears is similar to that for
of the Room Detail Menu. On the menu’s first row of
buttons, the following tabs from left to right are:
Information, Activity Log, Complaints, Needs, Favorite
Activities and Cheat Card. While on the second row the
buttons are as follows: See Guest’s Room, Center View on
Customer, Follow Customer and Switch Customer.

The Information button shows a customer’s detailed
information such as full name, age, overall impressions of
your hotel, his amount of spending, etc.

The Activity Log displays historical as well as current
data on the customer’s activities during his stay in your

hotel – allowing you to track the behaviors of individuals staying in your hotel.

The Needs and Complaints buttons, as the name suggests, shows the
individual guest’s needs and his complaints regarding your hotel. When the
specific customer has neither needs nor complaints, the respective buttons will
be clear of color. As the needs or complaints of the customers pile up, the buttons
will be filled with yellow and red for needs and complaints buttons respectively –
allowing you to quickly glance at the customer’s detail panel and know
immediately how disgruntled the guest currently is.

The Favorite Activities tab lists all of a particular customer’s favorite activities
(see Chapter 5 – Understanding Customer’s Favorite Activities.)

The Cheat Card button allows you to access the cheat menu (see Chapter 5 –
Using Cheat Cards.)

You may center your screen on the selected customer or follow the customer
around the hotel by selecting the Center View on Customer or Follow
Customer icons respectively. You can also go directly and inspect a
customer’s room. To do so, simply left click the See Guest’s Room icon

and you will be automatically transported to the customer’s room.
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Overall Customer Satisfaction
Your hotel’s overall customer satisfaction, which takes into account all
satisfaction factors, can be seen on the Customer Satisfaction Screen in the
Information Screen. On the same screen, you can also see a list of satisfaction
ratings for different categories, each contri¬buting to the overall customer
satisfaction.

The weight percentage on the list tells how much contribution an individual
category rating has to the overall satisfaction rating. For example, if a hotel has a
satisfaction rating of 60 for its restaurant category and its weight is 10%, it
means that it will contribute 6 points to the overall customer satisfaction rating.

The weights will vary among different hotel types. For instance, the weight
‘business center’ will be higher for an urban modern hotel than for a resort hotel,
as people who stay in a resort hotel have less need for business facilities.
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The Different Types of Customer Satisfaction

The satisfaction of an individual customer

It represents the individual customer’s satisfaction towards your hotel.

Where to find it:

1) On the Customer Detail Menu, which can be accessed by double clicking
on a customer.

2) On the Customer List, which can be opened by left clicking on the
Customer List button on the Tool Wheel.

A guest room type or a facility’s customer satisfaction

This is the collective feedback from all customers who have used the guest
room or facility.

Where to find it:

1) On the Room Detail Menu, which can be accessed by double clicking on a
room.

2) On the Rooms and Facilities List which is opened by left clicking on the
Rooms and Facilities List button on the Tool Wheel.

3) On the Customer Satisfaction window under the Information Screen, which
shows a summary of customer satisfaction levels of guest rooms and
facilities in the hotel.

Overall customer satisfaction

This is a hotel’s overall customer satisfaction rating that encompasses all sat-
isfaction variables.

Where to find it:

1) On the Customer Satisfaction window under the Information Screen if you
choose to view a detailed breakdown by facility and room type.

2) For a simplified indication of the current rating left click the Overall
Customer Satisfaction button located at the Lower Toolbar
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5.2 UNDERSTANDING CUSTOMERS’
FAVORITE ACTIVITIES
A customer may have a list of their own favorite activities indica¬ted under the
Favorite Activities tab of the Customer Detail Menu.

When a customer performs one of their favorite activities, their satisfaction will
increase. Consequently reviewing your customer’s favorite activities list and
providing the necessary facility or service will greatly increase the overall
satisfaction rating and perception of your hotel.

What do customers wish for?
They may wish to use a specific item such as taking a
bath or exer¬cising in an exercise room. Or they may
wish for a specific service, such as receiving a
massage.
What is important to remember is the higher the quality
of item used or service provided the greater the
satisfaction bonus the customer receives. You must
therefore ensure that the service quality of your staff,
the quality of the facilities and the size of rooms is
sufficient. If a custo¬mer enjoys working out in a gym
but still has needs or complaints (e.g. the treadmill
could be better) you should address the request as soon
as possible in order to maximize the customer’s
satisfac¬tion increase.

5.3 UNDERSTANDING ROOM GRADES
The game assigns a room grade to each guest room ranging from Economy, Normal,

Deluxe I, Deluxe II, Suite, and finally Presidential Suite. Economy is at the
lowest-end while the Presidential Suite is the most luxurious grade
available.

You can see the room grade on a guest room’s Room Detail Menu.
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When a customer chooses a hotel to stay, most customers
already have in mind a preferred room grade. You can see
customers’ preference on room grades on the Market
Research screen in the Information Screen (see Chapter 4 –
Market Research.)

Your job as a hotel manager is to offer your customers with
guest rooms of the right room grades. But before you do so,
you must first understand how a guest room’s grade is
determined.

The following tables show the requirements for each room
grade.

Basic Requirements: 
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Required room
satisfaction 

Required room
size

Required 
sub-room

Economy 0-29
At least 25 

square meter 

Normale 30-49
At least 62.50
square meter 

Deluxe I 50-69 
At least 100.00
square meter 

Deluxe II 70-100
At least 137.50
square meter 

Suite 50-89
At least 137.50
square meter 

Bedroom

Presidential Suite 90-100 
At least 250.00
square meter 

Bedroom



Additional Requirement – the type of bed required for each room grade.

For example, to attain the “Suite” grade, a room must meet all of the following
requirements:

• Its customer satisfaction rating is 50 to 89 points

• Its room size is at least 137.50 square meters 

• It has a bed room 

• It has at least one of the following types of beds: one or two double beds, or
one canopy bed 

Offering Room Upgrades to Customers
If your hotel has at least two types of guest room layouts and at least
one vacancy of the better room type, some customers may be
interested in upgrading to another room to take advan¬tage of better
facilities within the new room.

Single bed 
More than One

Single Bed
Double Bed/
Canopy Bed

Two Double
Beds

Economy X X X X

Normale X X X X

Deluxe I X X X

Deluxe II X X X

Suite X X

Presidential
Suite

X X
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To find out if upgrading a guest is possi¬ble, select a
guest from your hotel by double clicking on a
customer or selecting a guest from the Customers
List under the Tool Wheel. Use the left right arrows
to cycle through your customers. Only those
customers currently inside your hotel will be listed. If
an upgrade is possible, the Room Upgrade button will
be present. When you left click the button you may
choose which room type the customer will be
upgrade to. You may also charge an upgrade fee at a
rate you decide. The customer may refuse the offer. If
so, try lowering the upgrade fee. If the customer
accepts your offer they will immediately move to the
new room.

Upgrading customers to better rooms will increase
their satisfac¬tion with your hotel.

5.4 USING CHEAT CARDS
To assist you in developing your hotel you are provided with cheat ‘cards’ that
once selected will force a customer to partake in an activity of your choosing. You
start with 30 cards. After each week of game time you are given an extra card.

To access the cheat cards you must first open a guest’s Customer Detail Panel
and left click the Cheat Card icon . Choose an activity from the drop down
menu and left click the OK button. After they have finished their present activity
the customer will carry out your chosen task. If you wish for the customer to stop
the selected task, select the Clear button.
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Hint: Cheat cards, when effectively used, can help you
achieve the goal of scoring a 100% customer satisfaction
rating.

You can also buy Cheat Cards but they are expensive at
$100,000 each. Left click the Buy button and decide how
many you wish to purchase.

5.5 ACHIEVING 100% CUSTOMER SATISFACTION
Having a customer achieve 100% satis¬faction is a noteworthy feat and
appro¬priately the ‘100% Customer Satisfac¬tion message box’ is displayed.

Having a customer with 100% satisfac¬tion rating will increase the perception of
your hotel and will encourage other customers to visit. It will also allow you to
unlock special reward items in the 100% Customer Satisfaction and Unlock
Items menu (found in the Information Screen) for use in your hotel.

Ways to increase satisfaction instantly:
• Offer a Room upgrade free of charge or at a low cost to the customer 
• Add facilities that are in a customer’s Favorite Activities list 
• Order a customer to perform an activity that will bring high satisfaction by using

a Cheat Card
• Taking care of your guests’ Special Needs

The number of customers who have reached 100% satisfaction is
displayed in the Corporate Profile screen.
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Taking Care of Guests’ Special Needs
While you are browsing through your customer’s’ Needs
panel, you may come across a customer who has a
special request from your hotel. These special needs are
marked with a Grant the Wish button underneath them.

Granting these requests will increase their satisfaction
with your hotel. Some guests
will even thank you for your
hospitality by gifting you with a
souvenir. Collecting these
souvenir items will give you a
bonus increase to your final
game score, so always be on a
look out for guests with special
needs.

5.6 SETTING UP A SUCCESSFUL RESTAURANT
As mentioned previously, setting up a restaurant in your hotel is an optional
choice but a prudent one. It provides a convenient place for your guests to dine,
and it is a facility that can attract potential customers who are not staying guests
in your hotel.

Aside from the requisite kitchen sub-room, two other objects are required in the
dining area, the reservation desk – where guests await to be seated – and the
cash register – where the diners pay for their food.

One thing that you must remember is that before you open any restaurant for business,
you should choose which type cuisine it specializes in and set up the restaurant's ala
carte menu. There are four types of cuisines to designate your restaurant: French,
Italian, German, and American. To choose the restaurant’s cuisine specialty, open the
restaurant’s detail menu and select your choice of cuisine from the panel.
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You can define a restaurant’s menu from the Food Course
Window. This window can be accessed by pressing the Food
button on the restaurant’s detail panel. The food window
shows all the recipes that you possess under the five recipe
categories of breakfast, appetizers, soups, main courses and
desserts.
You can browse the recipes within the selected category by
clicking on the left and right arrows at the bottom of the
window. When you have found the recipe that you’d like to add
to the food menu, you can click on the checkbox next to
”Add to the menu” and it will copy the recipe to your menu
automatically.

Besides serving your customers with a traditional ala carte
menu, you may also choose to offer a buffet meal in your
restaurant. Should you choose to do so, simply open the
cuisine drop-down list from the restaurant’s detail panel,
choose “Buffet” as the cuisine type and add a “Buffet Bar”
object into your restaurant’s dining area.

If you wish, you may change the number of captains and
servers in the restaurant from the restaurant menu.

You can also adjust the quality of the ingredients in your food as well as the price,
on a scale of 1 (lowest) to 10 (highest). Higher quality ingredients will result in
higher quality food. Always remember that raising quality also has the adverse
effect of the driving your costs higher. Keep this in mind and be mindful of your
bottom-line.
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5.7 UNDERSTANDING YOUR STAFF
The Staff Detail Menu displays a selected staff member’s details such as age,
work experience, service quality and monthly salary. To open the Staff Detail
Menu, simply double click on the specific staff that you wish to view or select the
person from the Staff List that is located at the Tool Wheel.
The buttons at the base of the detail menu display can be used to replace the
employee – useful if you’ve been getting complaints from customers – to
center the view on the employee , follow the employee around the hotel or
cycle through all of your employees.

You can further adjust your hotel’s staff policy by going to the Employment
Policies screen (found in Hotel Details under the Information Screen) and refining
it there (see Chapter 4 – Hotel Details.) 
In order to provide uniformly good service to your customers, you should spot
under-performing employees whose service quality is below your expectations
and replace them with a new and better employee. Increasing the budget for
employee training is also a good means to improve your staff’s service quality.

5.8 IMPROVING YOUR HOTEL’S OCCUPANCY
One of the key strategies in improving your hotel’s occupancy is to regularly study
the Market Research screen under the Information Screen. This screen can
give you a comprehensive overview of custo¬mer demands and how well your
hotel is meeting those demands. If, after analyzing the market research data, you
take the corresponding actions to address any shortcomings that your hotel may
have, you should in most cases see an increase in your hotel’s occupancy.
Needless to say, increasing customer satisfaction by providing higher quality
rooms with reasonable rates will earn you their loyalty and improve your hotel’s
occupancy.
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5.9 IMPROVING YOUR HOTEL’S PROFIT
While guest rooms may be the single largest source of income for your hotel, the
combi¬ned earnings of different facilities such as restaurants and bars can easily
outstrip your guest room income and generate more profits for you.

A facility’s income is affected by:
1) Its quality, which encompasses factors such as the size of the facility and the

quality and variety of its objects.
2) The facility’s pricing.
3) The number of guests and visitors in the hotel. If your hotel manages to attract

a larger number of people, each facility will have more potential customers.

In addition, you should also pay attention to the maintenance costs of objects
which are incur¬red monthly. Objects with high maintenance costs that do not
generate decent earnings will undermine your hotel’s profitability and should
probably be removed.

5.10 ACHIEVING A HIGHER HOTEL CLASS
Two requisites of achieving a high hotel class rating are high overall customer
satisfaction and high average staff service quality.

Overall customer satisfaction is displayed on the Customer Satisfaction screen
in the Infor¬mation Screen. Average staff service quality, on the other hand, is
displayed on the Employment Policies screen in the Information Screen.

The following table shows the requirements for achieving different hotel classes.
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5.11 STRATEGY TIPS
You can access quick strategy tips by clicking the Strategy Tips button on the
lower toolbar.

Selecting the button will make a pop-up window appear displaying advice on how
to better play the game. Use the “previous” or “next” tip arrows to move through
the available tips. Close the window by left clicking the close arrow or right click
the mouse.
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Hotel Class 
(Numbers of Stars) 

Required Overall
Customer Satisfaction % 

Required Average Staff
Service Quality Level

0,5 15-29 0

1 30-37 0,5

1,5 38-44 1

2 45-52 1,5

2,5 53-59 2

3 60-67 2,5

3,5 68-74 3

4 75-82 3,5

4,5 83-89 4

5 90-100 4,5



APPENDIX A - HOTEL GIANT SHORTCUT KEYS
Shortcut keys for both the interior and exterior modes:

F1 – Information center
F2 – Interior mode 
F3 – Exterior mode 
F4 – Game Goal screen 
F5 – Score screen
F6 – Customer List
F7 – Staff List
F8 – Rooms and Facilities List
F9 – Hotel Detail - Customer Satisfaction screen
F10 – Market Research screen
F11 – Save layout menu
F12 – Load layout menu
Echap – Game menu
'S' ou 's' – Save game menu
'L' ou 'l' –  Load game menu
'0' – pause the game
'1' – normal speed
‘2' – higher speed
'3' – fast forward
'7' – advance one week
'G' or 'g' – show/hide the mini-map and game menu
'M' or 'm' – show/hide the message log window
'O' – open the Options menu
‘P’ – Take a photo
Arrow keys – scroll camera view
Backspace – clear all the news messages on the screen.
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Shortcut keys for the interior mode only:
'Q’, 'W' & 'E' – switching view mode between isometric, perspective and top-
down modes.

'R', 'T' & 'Y' – switching wall modes between hide walls, show back walls and
show all walls.

‘D’ & ‘F’ – change the texture set of the selected layout or ground floor.

'Z' & 'X' – change the Wall texture of the selected layout or ground floor.

'C' & 'V' – change the Floor texture of the selected layout or ground floor.

'B' & 'N' – change the Ceiling texture of the selected layout or ground floor.

'[' & ']' – when selecting a location to add a new object, use these keys to change
the object being added.

ALT + left click on an object – add a new instance of the selected object.

PGUP & PGDN – Go up/down one floor.

‘U‘ – select a room and press this key to set the room’s default texture to the
currently selected textures.

Enter – open the “Object, Texture and Room” menu.

Space – display the “Add Object” menu. It has the same effect as clicking on the
“Object” button on the bottom menu bar.

Tab – display the “Texture” menu. It has the same effect as clicking on the
“Texture” button on the bottom menu bar.

` – display the “Room” menu. It has the same effect as clicking on the “Room”
button on the bottom menu bar.

‘A’ and ‘D’ – rotate an object while choosing a location to place the object.

‘,’ and ‘.’ – browse guest units while the guest detail panel is open, or browse the
staff units while the staff detail panel is open.
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